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1 Introduction
SolGasWater was elaborated at the Department of inorganic chemistry at Umeå
University (Eriksson 1979). The program was developed in a DOS environment and
enabled computerised calculations of large and complicated chemical equilibrium
systems. The program made it possible to carry out these types of calculations on an
ordinary computer and therefore became an appreciated tool for analyses of equilibrium
systems. During the years a number of modifications of the original code was carried out
aiming for a more powerful and flexible program. Due to the evolution of computer
technology during the last decade and the wish for a user-friendlier interface, adapted to
teaching and non-specialist scientists, an initiative to a new Windows based SolGasWater
(WinSGW) was taken in 1999. This initiative together with the results of continuous tests
with the program by students and scientists at Umeå University lead to even further
development of the original SolGasWater code in cooperation with Gunnar Eriksson.
Parallel to this work new models were incorporated to adapt to the present requirements
of the scientific world.
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2 Theory
All equilibrium analytical calculations are in principle based on the same fundamental
concepts and formulaes. These concepts form the general computational basis in
WinSGW and are described below.

2.1 The equilibrium reaction
The equilibrium reaction states the type of chemical equilibria that will be used for
describing a given chemical system. It gives the relationship between components A, B,
C, ... and formed complexes ApBqCr…:
[1]

→ ApBqCr…
pA + qB + rC … ←

where p, q, r,… are the stoichiometric coefficients in the reaction. The phase notations in
reaction [1] have been omitted but will be commented on below. Depending on how the
components have been chosen, the pqr-values may attain positive or negative values,
which means that the component in question is consumed or formed. Negative values are
for instance found when component A represents the proton and a deprotonation or
hydrolysis reaction is considered. The components A, B, C in [1] can be denoted (1,0,0),
(0,1,0) and (0,0,1). This formalism has been shown to be a very convenient basis for the
general mathematical-numerical treatment of complicated equilibrium systems. Sillén
and his co-workers (Dyrssen 1961) were the first to use it and numerous examples can,
for instance, be found in publications from the Departments of Inorganic Chemistry at
KTH, Stockholm and at Umeå University.
Following a commonly used nomenclature, both components and complexes will be
denoted as species. As a rule, chemically well characterised, preferably mononuclear,
species should be chosen as components. The number of components is defined as the
smallest number of species by which all other species can be expressed; i.e. the
components are the independent variables being used when solving the mass balance
equations. For example when H+ is chosen as a component, OH- is considered as a
complex and vice versa. In WinSGW even solid phases, gas molecules, and active sites
on a particle surface will be referred to as species.
In most common cases all species are present in an aqueous phase (aq). However, the
WinSGW program can handle other fluid phases as well as coupled equilibria between
aqueous species, species in a gas phase, solid phases, species at the surfaces of solid
phases (commonly referred to as surface complexes) and species in a Donnan phase. The
program can handle up to 300 species formed from a maximum of 15 components, of
which 5 can be surface components. Within the calculations a maximum of 31 solid
phases are allowed.

2

2.2 The Law of Mass Action and the Formation Constant
The Law of mass action determines the activity relations between components and
formed complexes. Provided that the activity coefficients are kept constant, the
concentration of each species, x, can then be calculated from:
[2]

[x] = β ⋅ a p b q c r K

where [x] and a, b, c,… are the equilibrium concentrations of the formed species and
components respectively, and β is the formation (equilibrium) constant for the species
formed. The formation constant is dependent on temperature (T ), ionic strength (I ) and,
in the case of surface complexes, also the charge at the surface ( cf. paragraphs 2.4, 2.5
and 2.6).

2.3 Mass balance equations
The total concentration of each component is given by the mass balance equations:

A = a + ∑ p ⋅β ⋅ a p b q c r K = ∑ p ⋅ [x]

[3]

x

B = b + ∑ q ⋅β ⋅ a p b q c r K = ∑ q ⋅ [x]

[4]

x

C = c + ∑ r ⋅β ⋅ a p b q c r K = ∑ r ⋅ [x]

[5]

x

.
.
.

2.4 Temperature dependency of the formation constant
In WinSGW it is possible to perform calculations at other temperatures than the one for
which the formation constants are given by using the van’t Hoff equation. The van’t
Hoffs equation can be derived from basic thermodynamic relationships relating the Gibbs
free energy and the equilibrium constant. The deviation from a given reference
temperature at which the formation constant is given can, accordingly, be calculated:

log β T2 = log β T1 −

∆H o  1 1 
 − 
R ⋅ ln10  T2 T1 

[6]

Here βT is the formation constant at temperature T (K), R is the molar gas constant and
∆Ho (J/mole) is the molar enthalpy for the reaction. Equation [6] can be used provided
that the temperature dependency in ∆Ho can be neglected.
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2.5 Ionic strength dependency of the formation constant
The activity of a species, x, is defined as:

{x} = [x]⋅ f x

[7]

where fx is the activity coefficient for species x. This activity coefficient is dependent on
the ionic strength of the solution and, as a consequence, the formation constant is
dependent on the ionic strength as:
log β = log β 0 + p log fa + q log f b + r log f c + ... − log f x

[8]

In this equation β 0 is the formation constant at infinite dilution (ionic strength equal to
zero). To model the ionic strength behaviour of activity coefficients, different
relationships can be used (Stumm, Morgan 1996). In WinSGW the following five
equations are available:
log f = − Az 2 I



I
log f = − Az 2 
− b ⋅ I 
1+ B ⋅ a I


Debye-Hückel

[9]

Extended Debye-Hückel

[10]

I

log f = − Az 2

Güntelberg [11]
1+ I


I
log f = − Az 2 
− d ⋅ I 
Davies [12]
1+ I



I
+ e⋅I
log f = − Az 2 
Specific Ion interaction Theory [13]

1+ B ⋅ a ⋅ I 
The SIT-model is sometimes also referred to as the Brønsted-Guggenheim-Scatchard
(Brönsted 1922; Guggenheim 1935; Scatchard 1936) model and is the preferred model
within the NEA Thermochemical Data Base (TDB) project, e.g., (Wanner and Forest,
eds. 1992, Olin et al. 2005). In these equations z is the charge of a species and I is the
molar ionic strength of the solution. b and d are constants supplied by the user as well as
a and e which are species specific constants. A and B are given by the following
equations:
A = 1.82 ⋅10 6 ⋅ (εT )
B = 50.3 ⋅ (εT )

−1

−3

[14]

2

[15]

2

where ε is the dielectric constant of the solvent at the absolute temperature T. In
WinSGW is not equation [15] used in combination with equation [13], instead is the user
asked to give a value for B·a.
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The ionic strength, I (M), is calculated through an iterative process in WinSGW from the
resulting species distribution as:
1
I = ∑ [x ] ⋅ z 2
[16]
2
where the electric charge balance requirement is fulfilled via the “Background
electrolyte” information supplied. For details, see paragraph 5.4.
In addition to these five relationships between the activity coefficient and the ionic
strength (i.e., eqs. [9] to [13]), it is also possible to use the Pitzer theory (simplified) in
WinSGW. Details and advantages of this method are described in detail by Harvie and
Weare (1980).

2.6 Surface charge dependency of the formation constant
Reactions at the surface/solvent interface will result in charge accumulation at the
surface, and the apparent equilibrium constants for the reactions will not be constant. To
mathematically model this effect, a handful of electrostatic expressions have been
developed according to the theories for electric double layers at such interfaces.
In WinSGW six different electrostatic models can be chosen; the Constant Capacitance
Model (CCM), the Extended Constant Capacitance Model (ECCM), the Diffuse Layer
Model (DLM), the Stern Model (Stern), the Triple Layer Model (TLM) and the Three
Plane Model (TPM). These models describe the relationship between the surface
potential, ψ, and the density of charge at a particle surface. Depending on the model, the
charge can be distributed over one, two or three planes (cf. Figures 1-6). In addition to
these planes a diffuse layer of electrolyte ions (with surface potential ψdiff) is present in
the DLM, Stern, TLM and TPM models.
The effect of charge accumulation on the formation constant of an individual species can
be calculated from:
∆Gapp = ∆Gint + ∆Q0 Fψ 0 + ∆Q1 Fψ 1 + ∆Q2 Fψ 2

[17]

where ∆Gapp and ∆Gint are the apparent and intrinsic Gibbs free energies of surface
complex formation, respectively. ∆Qn and ψn (mV) are the changes in charges and the
surface potential at the 0-, 1- and 2-planes, respectively (∆Qn is often referred to as ∆Zn in
the literature). To calculate the overall equilibrium constant the coulombic correction
term and the intrinsic equilibrium constant are required. The apparent formation
constants, βapp, are corrected for coulombic energy to obtain intrinsic constants β int
according to:

β (int) = β ( app ) ⋅ e ∆Q Fψ
0

0

/ RT

⋅ e ∆Q1Fψ 1 / RT ⋅ e ∆Q2 Fψ 2 / RT

[18]

where F is Faraday’s constant. The molar concentration of charge at surface plane n,
T(σn), (mol⋅dm-3), can be calculated from:
T (σ n ) = ∑ Qn ⋅ [x]

[19]

and expressed as density of charge at the surface, σn, (C⋅m-2):
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σn =

T (σ n ) ⋅ F
SolCon ⋅ SpArea

[20]

where SolCon is the concentration of solid (g⋅dm-3) and SpArea is the specific surface
area of the solid (m2⋅g-1).
In the case of the CCM (Schindler, Gamsjäger 1972), ψ1, ψ2 and ψdiff are not defined and
ψ0 is given by:

ψ0 =

σ0

[21]

C

where C is the specific capacitance (C⋅V-1⋅m-2). By inserting this value into equation [18]
the equilibrium constant can be corrected for electrostatic forces. In Figure 1 the
relationship between the potential and the distance from the surface is illustrated.

Figure 1.

An illustration of the electrostatic behaviour at the surface/water
interface according to the Constant Capacitance Model

For the ECCM (cf. Figure 2) (Nilsson et al. 1996) in which two planes are present (ψ2
and ψdiff not defined) the overall specific capacitance, C, is given by C1 (between the 0plane and the 1-plane) and C2 (between the 1-plane and the bulk solution) according to:
1 1
1
=
+
C C1 C 2

[22]

The following equations are valid for the relations between the potentials and the charges
at the 0-plane and the 1-plane respectively:
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ψ1 =

σ 0 +σ1

[23]

C2

ψ 0 −ψ 1 =

σ0

[24]

C1

Using these results in equation [18] makes it possible to determine the apparent
equilibrium constant.

Figure 2.

An illustration of the electrostatic behaviour at the surface/water
interface according to the Extended Constant Capacitance Model

In the electrostatic models including a diffuse layer, the charge, σdiff, is obtained from the
electro neutrality condition for the particles:
[25]

σ 0 + σ 1 + σ 2 + σ diff = 0
and the potential in the diffuse layer is given by the Gouy-Chapman equation:
2 ⋅ R ⋅T
ψ diff =
sinh −1 σ diff ⋅ 8000 ⋅ ε ⋅ ε 0 ⋅ R ⋅ T ⋅ I
F

(

)

[26]

In this equation I is the ionic strength of the solution (cf. Eq. [16]) and ε0 is the
permittivity of vacuum.
The DLM (Figure 3) (Stumm et al. 1970; Huang, Stumm 1973) involves one plane (the
0-plane) and a diffuse layer. The surface charge densities, σ0 and σdiff, are given by
equations [20] and [25]. The potential ψdiff is calculated using equation [26] and the
potential at the 0-, 1- and 2-planes are equal to the potential at the diffuse layer
(ψ0 =ψ1 =ψ2=ψdiff). By inserting these values into equation [18] the apparent equilibrium
constant, βapp, can be calculated.
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Figure 3.

An illustration of the electrostatic behaviour at the surface/water
interface according to the Diffuse Layer Model

In the Stern model two planes (the 0-plane and the 2-plane) (Stern 1924; Westall,
Hohl 1980) and a diffuse layer are used (Figure 4). As in the DLM case the surface
charge densities are given by equations [20] and [25] and the potential in the diffuse layer
is given by equation [26]. The surface potential at the 1- and 2-planes are equal to the
potential at the head end of the diffuse layer and ψ0 is obtained from:

ψ 0 −ψ 2 =

σ0

[27]

C

By inserting these values into equation [18] the apparent equilibrium constant can be
corrected for the charge dependence.

Figure 4.

An illustration of the electrostatic behaviour at the surface/water
interface according to the Basic Stern Model
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The Triple Layer Model (TLM) (Figure 5) (Yates et al. 1974; Davis et al. 1978) involves
two planes (the 0-plane and the 1-plane) and a diffuse layer. The surface charge densities
are given in analogy to the previously presented models and surface potentials (ψ0, ψ1,
ψdiff) are obtained using equations [23], [24] and [26]. ψ2 is given by:

ψ 2 = ψ diff

[28]

Using these potentials the charge dependence for the equilibrium constant can be
determined.

Figure 5.

An illustration of the electrostatic behaviour at the surface/water
interface according to the Triple Layer Model

Finally, in the TPM (Hiemstra, Van Riemsdijk 1996) three planes of absorbed ions and a
diffuse layer of electrolyte ions are used. The surface charge densities are given by
equations [20] and [25], and from equations [23], [24], [26] and [28] the surface
potentials are obtained (Figure 6). Inserting these potentials into equation [18] makes it
possible to correct the βapp-constant for the build-up of electrostatic charges at the
surface.

Figure 6.

An illustration of the electrostatic behaviour at the surface/water
interface according to the Three Plane Model
9

2.7 Unspecific interactions according to Donnan ion exchange
theory
The Donnan equations (Donnan, Harris 1911) used in WinSGW were derived to describe
the distribution of ions between a water volume confined to a wood fibre and a
suspension liquid in a pulp suspension. Therefore it is assumed that at least one
negatively charged surface species (Q0 < 0) is present. It is also assumed that this charged
surface species has access to the fibre volume (commonly referred to as the Donnan
volume) and gives rise to a potential, which results in an uneven distribution of ions
between the two sub-volumes. In WinSGW it is also possible to define two charged
surface species giving rise to this potential and to calculate the distribution of ions with
charge from –5 to +7. According to the Donnan theory (Towers, Scallan 1996), the
distribution of an ion x between the Donnan volume (f) and the suspension liquid (s) is
given by:

[ ]
[ ]

 xz
λ =
 xz


f

s






1

z

[29]

where λ is the distribution coefficient and z is the charge (-5 ≤ z ≤ 7). In both of the
aqueous volumes, the requirement of electric neutrality must be met, i.e. the total positive
charge must equal the total negative charge. This can be expressed as:
−1

7

∑ z ⋅ [x ] = ∑ z ⋅ [x ]
z

z

s

z = −5

[30]

s

z =1

−1
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[ ] = ∑ z ⋅ [x ]

∑ Q0 ⋅[≡ x] f + ∑ z ⋅ x z

z

f

z = −5

[31]

f

z =1

where ≡x is the Q0 charged surface species giving rise to the Donnan potential. By
combining these equations with the mass balance equation an expression that contains the
total concentrations, total aqueous volume, specific Donnan volume, the mass of fibre
and λ is obtained. The following equation is an example of this relationship

(λ

2

) V ∑+[xD]⋅ m ⋅V⋅ (λ − 1) + 2 ⋅ (λ
+

)[ ] (

− 1 ⋅ H + s + λ2 − 1 ⋅

TOT

TOT

∑ [x ]
3 ⋅ (λ − 1)⋅
3+

4

TOT

⋅ VTOT

(

3

TOT

f

[≡ x ]⋅V
−λ⋅
−

TOT

)

VTOT + D ⋅ m f ⋅ λ3 − 1

D⋅mf

) V ∑+[xD ⋅]m ⋅⋅V(λ
2+

TOT

−1 ⋅

TOT

f

TOT
2

)+

−1

[32]

=0

Equation [31] is valid in a system where only protons, monovalent anions and mono-, diand trivalent cations are present. Furthermore, only one type of site is present on the
fibre. In the equation, [xz+]TOT denotes the total concentration of cations with charge z,
VTOT is the total volume, mf is the mass of fibre used in the experiment and D denotes the
specific Donnan volume per unit weight. The Donnan ion exchange theory applied to
10

pulp systems has been described in detail in the literature, e.g. Lindgren et al. 2001,
Norberg et al. 2001, Norberg et al. 2002.
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3 Calculations
The calculation in WinSGW follows the equations described above. The calculations are
performed by an updated version of the SOLGASWATER (Eriksson 1979) program in
which the free-energy minimisation method is applied to systems containing fluid
(aqueous), gaseous, solid, surface and Donnan phases.
The requested input to the program is:
a) a coherent description of all the equilibrium reactions that operates in the system and
b) an instruction with regard to the actual chemical conditions under which the system is
to be simulated.
With respect to the first issue, a set of components are chosen (cf. paragraph 2.1) and,
from these, the stoichiometric compositions and equilibrium constants for all appearing
species logically follows. A series of numerical examples illustrating this procedure are
presented in paragraphs 5.1, 5.2, 5.4, 5.5, and 5.6. Also illustrated in paragraphs 5.1 and
5.6 is the fact that this choice can be made in several ways, especially when the system
includes weak acids and/or redox reactions.
With respect to the second issue many options are available to the user, including both
discrete point calculations and serial calculations. The options are designed to allow for
the user to calculate the equilibrium composition when the total or free concentrations of
the components are known, or to calculate the composition necessary to reach a given
point, but they are also designed to make it possible to simulate titration curves, Z-curves,
logarithmic diagrams, distribution diagrams, predominance area diagrams (so-called
“Pourbaix diagrams” when describing redox systems), and so on. Many of these latter
options are exemplified in paragraph 5.
When numerically defining the total concentration corresponding to a certain discrete
point an intellectual challenge is sometimes met since, depending on the choice of
components, the total concentration of H+ (and e-) can attain a negative value. This
follows mathematically from the fact that OH-, and species which are more deprotonated
than the chosen weak acid(s) component(s), are assigned negative proton stoichiometric
coefficients in the chemical matrix. (With respect to the electron content, this same holds
for redox species which are more oxidized than the component chosen.)
A numerical example illustrating the situation is presented in the latter part of paragraph
5.1. The interconnection between the component choice and the numerical value of the
total proton (electron) concentration, and the independence of the equilibrium
composition, is of utmost importance to realize.
Also vitally important to keep in mind when dealing with redox systems, is that {e-}
denotes a formal activity and not a chemical concentration. Therefore, this component
should always be assigned “Not Use” in the input matrix, cf. paragraph 5.4. By this, the
program correctly calculates the activity but puts the chemical concentration to zero.
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3.1 Options for simulation
The list presented below shows the available choices open to the user. For each
component in the system, one of the options is chosen on the “Variation for Each
Component” tab. Depending on the choices made, different information is requested on
the “Input data: Each component” tab and, if surfaces are being included, the “Input data:
Surfaces” tab.

Tc: Total Concentration for the actual component
a: Activity for the free amount of the actual component
Option 1:
Option 2:
Option 3:
Option 4:
Option 5:
Option 6:
Option 7:
Option 8:
Option 9:
Option 10:
Option 11:

Tc varies irregularly between each point
Tc is constant
Tc varies with constant steps
Tc varies through varied volume-additions
Tc varies through constant volume-additions
log Tc varies with constant steps
log Tc is dependent variable in predominance diagram
log a varies irregularly
log a is constant
log a varies with constant steps
log a is dependent variable in predominance diagram

For surface components the following options are available
Option 20:
Option 21:
Option 22:
Option 23:

Conc. of solid phase is constant
Conc. of solid phase varies with constant steps
Conc. of solid phase varies through titration with constant
volume-additions
Conc. of solid phase varies irregularly
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3.2 Results
The calculations result in a matrix of data containing all necessary information about the
equilibrium composition of the actual system. This information includes total
concentrations of all components, concentrations of all species and corresponding
activities. The matrix also includes the volume added, the total volume and the amounts
of solids formed etc.
This data is used within WinSGW to calculate all optional quantities in the “Display
Calculation Results” window.
The different options are:
[x] (mM) Conc.
log ([x]/M)
- log ([x]/M)
{a} Activity
log {a}
Tc (mM) Total conc.
log ( |Tc| / M )
Tf (mM) Total Conc. In
Fluid
log ( |Tf| / M )
Ts (mM) Total Conc. in
Solution

Fi (aq)

Concentration of the selected species or component in
milli molar units (10-3·mol·dm-3).
Logarithm of the selected species or component
concentration in molar units (mol·dm-3).
The negative logarithm of the selected species or
component concentration in molar units (mol·dm-3). Use
this option to display pH.
Activity of the selected species or component.
(cf. paragraph 2.5.)
Logarithm of the activity.
Total concentration of selected component in the system
(10-3·mol·dm-3).
Logarithm of the absolute total concentration Tc. Total
concentration in molar units (mol·dm-3).
Total concentration of selected component in the fluid
(aqueous) phase (excluding solid phases) in milli molar
units (10-3·mol·dm-3).
Logarithm of the absolute total concentration Tf
(mol·dm-3).
Total concentration of selected component in fluid
(aqueous) phase (excluding solid and surface phases) in
milli molar units (10-3·mol·dm-3).
The distribution of a component between the species.
Solid phases are not included.
Fx (aq) = n⋅[x] / Tf.
where n is the stoichiometric coefficient (cf. paragraph
2.1) for the component in species x, i.e. Fi (aq) is
corrected for polynuclearity (n > 1).
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Fi (s)

Z

n-bar

The distribution of a component between the species.
Solid phases included
Fx (s) = n⋅[x] / Tc.
where n is the stoichiometric coefficient (cf. paragraph
2.1) for the component in species x, i.e. Fi (s) is
corrected for polynuclearity (n > 1).
The average number of component A bound to another
component (B). E.g.: Number of protons (component A)
bound to component B is calculated as
A − H + + OH −
Z = TOT
BTOT
The average number of one component, regarded as a
ligand, bound to unit amount of another component,
regarded as the central atom. E.g.: Number of component
B bound to component C is calculated as
∑ q Ap Bq Cr ...
n=
CTOT
Added volume in a simulated titration (cm3).
Total volume in cm3 if “None” is chosen. The Donnan
volume is obtained if the Donnan active surface
component is chosen.
The species with the highest concentration containing the
chosen component. N.B. this function is not corrected for
polynuclearity (n > 1), cf. calculation of Fi (aq).
The solid phase concentration of the chosen surface
component (cf. Eq [20]).
The surface potential (ψ) for the chosen surface
component at the specified plane or diffuse layer
(Eq [18]).
The surface charge, T(σn), for the chosen surface
component at the specified plane (Eq [19]).
The ionic strength of the solution Eq [16].
The apparent log β value [8] for the chosen species or, if
no species is chosen, the Donnan distribution coefficient
λ, equation [29].
Clears the chosen column.

[ ] [

[

Vt (cm3)
Vtot / Donnan volume (cm3)
Dominating species
Conc. Surface Phase
(g/dm3)
Surface Pot. (mV)
Surf. Cha. (mol/dm3)
Ionic strength (mM)
log B / lambda
Empty

]

15

]

3.3 Diagrams
The results shown in the “Display Calculation Results” window (described above), and
chosen by the user, can be plotted in a diagram. For the construction of diagrams of
various types, such as distribution diagrams, pH diagrams, solubility diagrams, n-bar
diagrams, titration curves and so forth, the proper dependent (y-axis) and independent
variables (x-axis) are combined. The user makes these choices on the “Define Columns to
Plot” window. It is furthermore possible to enter a restriction for the plotting (low limit
value), i.e. a curve is not plotted if its highest y-value is below the limit value.

3.3.1 Predominance area diagrams
In addition to the user defined diagrams it is possible to make predominance area
diagrams where the species of the highest concentration are shown. The input for this
type of diagram is made before the calculation at the right on the “Variation for each
component” tab in the “Input for Solgaswater Calculation” window. There it is possible
to chose for which component the diagram should be constructed, if solids should be
included, and if polynuclearity (formula units) should be considered (cf. paragraph 5.4).
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5 Examples*
The majority of the equilibrium constants employed have been collected from Stumm, W.
and Morgan, J. J., Aquatic Cemistry, 3rd ed.. “pH” is regularly used to denote –log[H+].

5.1 Create a distribution diagram for the (H+-H3PO4) system
Task: Plot a diagram showing the distribution of phosphate species as a function of pH at
a total phosphoric acid concentration of 10 mM.
1. The following four equilibrium reactions describe a dilute phosphoric acid system.

1
2
3

→ H+ + OHH2O ←
→ H2PO4- + H+
H3PO4 ←
→ HPO42- + H+
H2PO4- ←

log β*
-14.00
-2.15
-7.20

4

-12.35
→ PO43- + H+
HPO42- ←
*Equilibrium constants valid at infinite dilution and at 25°C.
2. Define chemical components that can describe all species present (H+, OH-, H3PO4,
H2PO4-, HPO42- and PO43-). Components: a) H+ and H3PO4; b) H+ and PO433. Write a chemical matrix using the components and the equilibrium reactions.
a)
H+
H3PO4
OHH2PO4HPO42PO43b)
H+
PO43OHHPO42H2PO4H3PO4

log β
0
0
-14.00
-2.15
-9.35
-21.70
log β
0
0
-14.00
12.35
19.55
21.70

H+
1
0
-1
-1
-2
-3

H3PO4
0
1
0
1
1
1

H+
1
0
-1
1
2
3

PO430
1
0
1
1
1

Equilibria Nos.

1
2
2+3
2+3+4
Equilibria Nos.

1
-4
-4-3
-4-3-2

*Due to a continous development of the program, the screen captures in this section will not always be identical to
those appearing in the latest version of the WinSGW software.
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4. Start WinSGW and choose “New Chemical Matrix” from the “File” menu. Since
WinSGW has three components as default value, remove one by clicking on a “C” in the
“C*” column.

5. Enter the matrix. Blanks in the matrix will be interpreted as zeros by the program. By
clicking the right mouse button in the brownish line number column it is possible to
insert, clear and/or delete rows in the matrix.
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6. Move to next tab “Variation for each component”. At this tab we choose which kind of
calculation we aim at. There is a description of the possible choices in the yellow text
box. For this example we would like to vary pH in constant steps (Component 1 H+,
option 10) and to keep the total phosphoric acid concentration constant (Component 2
H3PO4, option 2).

7. Move to next tab “Input data: Each component”. Enter Start value “log {a}”, Step
length “Step” for the first component (H+), total concentration of phosphoric acid “Tc”
and the number of points. The program will calculate the log {a} value in the last
calculated point. In this position, it is advisable to save and/or print the matrix and the
input on the File menu.

8. Start the calculation by pressing the “Calculate” button or use the Calculate menu.
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9. Viewing the result.
Choose H+ in the Component/Species box and then “-log {[x]/M}” to view pH in column
1. Move to the next column. To display the distribution of H3PO4 choose a “phosphorus
containing species” in the Component/Species box, “Fi (aq)” and H3PO4 in the box next
to “Fi (aq)”. Repeat these steps for the remaining phosphate species.

Note that the results employing the two different choices of components, of course, are
identical.
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10. Plotting the results
Choose “Plot calculation data” from the “Diagrams” menu.
The default setting is that the first column in the Calculation Result grid contains
X-values and all remaining columns will be plotted on the Y-axis. It is possible to remove
a series from the Plot Columns list by clicking on the series. As an option you can choose
to exclude all curves that never exceed a given minimum value.
Continue by pressing “Plot diagram”.

11. The diagram
You can modify your chart by using the top buttons, e.g. change the scale, labels, lines
and symbols, or print your diagram.
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12. Without any renewed calculation, it is also possible to generate other relevant
diagrams describing the system. This is made by returning to the “Display Calculation
Results”, changing the column contents to the new information of interest, and plotting
these as described above.
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5.1.1 Calculate the equilibrium compositions for a series of
phosphate solutions
A series of solutions were prepared by mixing equal volumes of:
i)
ii)
iii)
iv)
v)
vi)

10 mM HCl and 10 mM H3PO4
10 mM NaOH and 10 mM H3PO4
10 mM H3PO4 and 10 mM NaH2PO4
5 mM NaOH and 10 mM Na2HPO4
10 mM NaH2PO4 and 10 mM Na3PO4
10 mM NaOH and 10 mM Na3PO4

Task: Calculate the equilibrium pH and the distribution between different phosphate
species.
1a). With H+ and H3PO4 as components, the total concentrations in the 6 solutions are:
i)
ii)
iii)
iv)
v)
vi)

[H]tot = (1·10 + 0)/2 mM = 5 mM;
[H]tot = (-1·10 + 0)/2 mM = -5 mM;
[H]tot = (0 + (-1)·10)/2 mM = -5 mM;
[H]tot = (-1·5 + (-2)·10)/2 mM = -12.5 mM;
[H]tot = (-1·10 + (-3)·10)/2 mM = -20 mM;
[H]tot = (-1·10 + (-3)·10)/2 mM = -20 mM;

[P]tot = (0 + 10)/2 mM = 5 mM
[P]tot = (0 + 10)/2 mM = 5 mM
[P]tot = (10 + 10)/2 mM = 10 mM
[P]tot = (0 + 10)/2 mM = 5 mM
[P]tot = (10 + 10)/2 mM = 10 mM
[P]tot = (0 + 10)/2 mM = 5 mM

1b). With H+ and PO43- as components, the total concentrations are:
i)
ii)
iii)
iv)
v)
vi)

[H]tot = (1·10 + 3·10)/2 mM = 20 mM;
[H]tot = (-1·10 + 3·10)/2 mM = 10 mM;
[H]tot = (3·10 + 2·10)/2 mM = 25 mM;
[H]tot = (-1·5 + 1·10)/2 mM = 2.5 mM;
[H]tot = (2·10 + 0)/2 mM = 10 mM;
[H]tot = (-1·10 + 0)/2 mM = -5 mM;

[P]tot = (0 + 10)/2 mM = 5 mM
[P]tot = (0 + 10)/2 mM = 5 mM
[P]tot = (10 + 10)/2 mM = 10 mM
[P]tot = (0 + 10)/2 mM = 5 mM
[P]tot = (10 + 10)/2 mM = 10 mM
[P]tot = (0 + 10)/2 mM = 5 mM

Note that the multiplication factors for calculating [H]tot are exactly the same as those
appearing in the chemical matrix, cf. p. 19.
2. Start WinSGW and choose ”Open” from the ”File” menu. Retrieve the file
“Example1a.cti” which was (hopefully) saved in the previous session. Otherwise, choose
“New Chemical Matrix” and re-enter the matrix.
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3. Move to the tab “Variation for each component”. This time we want to enter 6 discrete
data points where both total concentrations varies irregularly between the points
(Component 1 H+, option 1; Component 2 H3PO4, option 1).

4. Move to next tab “Input data: Each component” and enter the numerical values of Htot
and Ptot.

5. Calculate
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6. Choose H+ in the Component/Species box and then “Tf (mM) Total Conc in Fluid” to
display Htot in column 1. Move to the next column and display Ptot. The resulting
–log[H+] and the distribution between the different phosphate species are displayed as in
previous session.

7. Repeat steps 2 – 6 with H+ and PO43- as components, i.e. Example 1b), and note that
the results, of course, becomes exactly the same.
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5.2 Create a pH-diagram for the heterogeneous water-carbon
dioxide system
Task: Construct a pH diagram, plot the logarithmic concentrations of all species as
function of pH (0<pH<10), for the heterogeneous water - carbon dioxide system. Set the
partial carbon dioxide pressure to 1 atm.
1. The following four equilibrium reactions describe the water - carbon dioxide system.

1

→ H+ + OHH2O ←
→ H2CO3(aq)
CO2(g) + H2O ←
→ HCO3- + H+
H2CO3 (aq)←

2
3

log β*
-14.00
-1.47
-6.35

4

-10.33
→ CO32- + H+
HCO3- ←
*Equilibrium constants valid at infinite dilution and 25°C.
2. Define chemical components that can describe all species present (H+, OH-, CO2(g),
H2CO3(aq), HCO3-, CO32-).
Components: H+ and CO2(g)
3. Write a chemical matrix using the components and the equilibrium reactions.
+

H
CO2(g)
OHH2CO3 (aq)
HCO3CO32-

log β
0
0
-14.00
-1.47
-7.82
-18.15

H+
1
0
-1
0
-1
-2

CO2(g)
0
1
0
1
1
1

Equilibria Nos.

1
2
2+3
2+3+4
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4. Enter the matrix. Blanks in the matrix will be interpreted as zeros by the program. By
clicking the right mouse button in the first column it is possible to insert, clear and delete
rows in the matrix. Change the phase properties for CO2(g) to Gas.

5. Move to next tab “Variation for each component”. At this tab we choose which kind of
calculation we should do. For this example we would like to step pH (Component 1 H+,
option 10) and to keep the carbon dioxide activity (logarithmic) constant (Component 2
CO2(g), option 9).
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6. Move to next tab “Input data: Each component”. Enter Start value “log {a}”, Step
length “Step” for the first component (H+), the logarithmic carbon dioxide activity and
the number of points. Since the activity of a gas species is equal to its partial pressure, the
logarithmic activity will be 0.

7. Start the calculation by pressing the “Calculate” button or use the Calculate menu.
8. Viewing the result.
Choose H+ in the Component/Species box and then “-log {[x]/M}” to view pH in column
1. Display the logarithmic concentration of all soluble species present in the following
columns.
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9. Plotting the results
Choose “Plot calculation data” from the “Diagrams” menu.
The default setting is that the first column in the Calculation Result grid contains
X-values and all remaining columns will be plotted on the Y-axis. It is possible to remove
a series from the Plot Columns list by clicking on the series. As an option you can choose
to exclude all curves that never exceed a given value.
Continue by pressing “Plot diagram”.
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10. The diagram
You can modify your chart using the top buttons, e.g. change the scale, labels, lines and
symbols, or print your diagram. For example rescale Y-axis (min –8, max 0, origin 0).

32

5.3 Surface complexation models (H+-goethite)
Task: Compare experimental data points with a model calculation by plotting a diagram
showing the protonation of a goethite surface as a function of pH.
1. The following equilibrium reactions and electrostatic information describe the actual
chemical system.

1
2
3

→ H+ + OHH2O ←
→ ≡FeOH2+
≡FeOH + H+ ←
→ ≡FeO- + H+
≡FeOH ←

log β*
-13.775
7.47
-9.51

Additional information about the goethite system:
Surface site concentration

1.2 mmol/dm3

Solid phase concentration

11 g/dm3

Specific surface area

39.9 m2/g

Specific capacitance

1.28 C/V·m2 *

*Constants valid at 25°C and 100mM (NaNO3).
2. Two components: H+ and ≡FeOH
3. The chemical matrix and the surface charges.
H+
≡FeOH
OH≡FeOH2+
≡FeO-

log β
0
0
-13.775
7.47
-9.51

H+
1
0
-1
1
-1

≡FeOH
0
1
0
1
1

Q0

Q1

Q2

0

0

0

1
-1

0
0

0
0

WinSGW can simultaneously model inner-sphere complexes in the 0-plane (the plane of
the surface sites), outer-sphere complexes in the 1-plane, electrolyte ion pairs in the
2-plane, and the diffuse layer of electrolyte ions.
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4. Start WinSGW and enter the matrix. By changing the Phase properties of ≡FeOH from
“Soluble” to “Surf.Comp.” the surface charge columns become visible. It is only possible
to enter surface charge for species with “Surf.Comp.” or “Surface” as the Phase property.
The default model in WinSGW is CCM and, to open the columns for Q1 and Q2, the
relevant surface charge model is chosen on the tab “Input data: Surfaces”.

5. Under “About…” it is possible to enter information about the chemical system e.g.
temperature, ionic strength and references.
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6. Move to next tab “Variation for each component”.
Choose to make constant steps in pH and to keep the total concentration of goethite
constant. (Component 1 H+, option 10; Component 2 ≡FeOH, option 2; Surface 1
≡FeOH, option 20).

7. On the “Input data: Each component” tab, enter the start value of “log {a}”, the step
length “Step” for the first component H+, the total concentration of goethite “Tc” and the
number of points.
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8. Move to next tab “Input data: Surfaces”. WinSGW can apply different electrostatic
models to describe the double layer at the surface. Depending on the model, different
charge columns (Q0, Q1 and Q2) will be activated on the Chemical Matrix tab and the
program will prompt for one or two capacitance values. To activate the ionic strength
dependent electrostatic models, the ionic strength check box on tab “Chemical Matrix”
must be marked. In this example the Constant Capacitance Model is to be used. Enter
values for solid phase concentration, capacitance 1 and the specific surface area.
N.B. In the yellow text box references describing the different models are listed.

9. Start the calculation.
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10. Viewing the result
View pH in the first column and Z in the second column (Choose H+ in the
Component/Species box, “Z” and ≡FeOH in the box next to “Z”). Z is calculated as the
average number of protons taken up by ≡FeOH.

11. Plotting the results
Plot Z as a function of pH.
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12. Insert experimental data points in the chart
Choose Insert Data at the top of the chart and enter your experimental values or paste
them using the Windows Clipboard.
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5.4 Create a predominance area diagram (H+-Fe2+-e-)
Task: Plot a diagram showing the predominating iron species as a function of pH and pe
for the H+-Fe2+-e- system. This type of plot is commonly referred to as a predominance
area diagram.
NB. pe is the negative logarithm of the formal electron activity and can be correlated to
the NHE (normal hydrogen electrode) electrode potential (EH, mV) with the following
equations:
g =RT ln(10) / F
pe = EH / g
(R: molar gas constant, T: absolute temperature in Kelvin, F: Faradays constant)
With EH plotted on the Y-axis, the diagram is usually referred to as a Pourbaix diagram.
1. The following equilibrium reactions describe the actual chemical system.
log β*
-14.00

1

→ H + OH
H2O ←

2

4.5

3

→ FeOH+
Fe2+ + OH- ←
→ Fe(OH)2(aq)
Fe2+ + 2OH- ←

4

→ Fe(OH)3Fe2+ + 3OH- ←

11.0

5

15.1

6

→ Fe(OH)2(s)
Fe2+ + 2OH- ←
→ Fe(OH)2+
Fe3+ + OH- ←

11.8

7

→ Fe(OH)2+
Fe3+ + 2OH- ←

22.3

8

→ Fe(OH)4Fe3+ + 4OH- ←
→ Fe2(OH)24+
2Fe3+ + 2OH- ←

34.4

9

+

-

7.4

25.0

10 Fe3+ + 3OH- ←
→ Fe(OH)3(am)
11 Fe3+ + e- ←
→ Fe2+

38.8
13.0

12 Fe2+ + 2e- ←
→ Fe(s)

-13.8

*Constants valid at 25°C and at infinite dilution.
2. Three components: H+, Fe2+ and e-.

39

3. The chemical matrix.
+

H
Fe2+
eOHFeOH+
Fe(OH)2(aq)
Fe(OH)3Fe3+
FeOH2+
Fe(OH)2+
Fe(OH)4Fe2(OH)24+
Fe(OH)2(s)
Fe(OH)3(am)
Fe(s)

log β
0
0
0
-14.0
-9.5
-20.6
-31.0
-13.0
-15.2
-18.7
-34.6
-29.0
-12.9
-16.2
-13.8

H+
1
0
0
-1
-1
-2
-3
0
-1
-2
-4
-2
-2
-3
0

Fe2+
0
1
0
0
1
1
1
1
1
1
1
2
1
1
1

e0
0
1
0
0
0
0
-1
-1
-1
-1
-2
0
-1
2

Equilibria Nos.

1
1+2
2·1+3
3·1+4
-11
1 + 6 - 11
2 · 1 + 7 - 11
4 · 1 + 8 - 11
2 · 1 + 9 - 2 · 11
2·1+5
3 · 1 + 10 - 11
12

4. Start WinSGW and enter the matrix. Remember to change “Usage” to Not Use for the
component e- (cf. p. 12) and “Phase” to Solid for the three solids.
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5. Move to next tab “Variation for each component”.
Choose to step pH, to keep the total concentration of iron constant and to step pe (as
dependent variable).
(Component 1 H+, option 10; Component 2 Fe2+, option 2; Component 3 e-, option 11).

6. Choose the component (Fe2+) for which the predominance area diagram should be
constructed. Check the sign boxes to plot pH and pe instead of log[H+] and log{e-} on the
axis.
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7. On the “Input data: Each component” tab, enter start value “log {a}”, step length
“Step” for the first and third components (H+ and e-), the total concentration of Fe2+ “Tc”
and the number of points and groups. In this example 899 (29 times 31) equilibrium
points will calculated, which might take some time depending on the actual computer
performance. In WinSGW there is a limit for the maximum calculation time (default
30 seconds) that can be changed. This can be done at “Preferences” (Option tab) on the
“File” menu.

8. Start the calculation.
9. Viewing the results.
Choose “Predominance diagram” from the “Diagrams” menu.
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10. To include solids in the diagram return to the input (activate “Chemical Matrix” on
the “View” menu) and, on the “Variation for each component” tab, mark “Incl. solids of
component”. This implies that if a solid forms it will be plotted. It is also possible to
include all solids (i.e. also solids not containing the specified component, Fe2+) and to
correct for formula units (poly-nuclear complexes).

11. Start the calculation (Short-cut key, <F9>) and plot the new predominance area
diagram.
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5.5 Ionic strength dependent constants
Task 1: Calculate log{H+} of 1, 5 and 10mM HCl and NaOH solutions in 500mM
(NaCl) at 50°C using the Güntelberg, Davies, and Pitzer equations to calculate the
activity coefficients at the actual ionic strength. The (NaCl) notation is used to imply that
the solution, in addition to the HCl or NaOH added, also contain dissolved sodium
chloride salt of the given concentration.
1. One equilibrium reaction describes the actual chemical system.

1

→ H+ + OHH2O ←

log β
-13.24

This constant is valid at 50°C and at infinite dilution. For WinSGW calculations
involving activity coefficients, the log β constants must be given at infinite dilution.
At 50°C the dielectric constant for water is 69.90 (ε is needed to calculate the activity
coefficients, cf. paragraph 2.5).
2. One component: H+
3. The chemical matrix and the charge of the component (z)
+

H
OH-

log β
0
-13.24

H+
1
-1

z
1

4. Start WinSGW and enter the matrix. Mark the “Use ionic strength calculations” box
which activates the charge column (z) and the “Calculate at a different temperature” box.
Only the charge of the components needs to be given.
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5. On the “Variation for each component” tab choose to vary the total concentration of H+
irregularly (Component 1 H+, option 1).

6. On the “Input data: Each component” tab enter the total concentrations of H+.
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7. Move to the “Ionic Media, Donnan and Temperature” tab and enter the temperature (in
degrees Celsius), the dielectric constant of water (ε), and information with respect to the
background electrolyte concentration.
Here, three different situations can be distinguished. Thus, the solutions can be prepared
to contain a given salt concentration in addition to the system of interest, or they can be
made to contain either a constant cation, or anion, concentration of the ionic medium.
The notations for these three options are (XZ), X(Y), and(X)Y, respectively (e.g. 0.1 M
(Na2SO4), 0.5 M K(Cl), 3 M (Na)ClO4).
In the first case, the charge and concentration of both ions are entered, and WinSGW
solves for the charge balance by “adding” an extra amount of cations or anions with the
charge given. This is made also in the second (and third) case, but here the input
concentration of the anion (cation) is given as zero.

8. Calculate
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9. Results
View log{H+}, the ionic strength and log β for the formation of OH- in columns.
(Col. 1: H+, log{a}; Col. 2: None, Ionic strength; Col. 3: OH-, log β/lambda)

10. Change “Ionic strength model” to Davies (To activate the input again, choose
Chemical matrix in the View menu) and recalculate.
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11. Change “Ionic strength model” to Pitzer and make a new calculation.

Task 2: Calculate, as a function of log{H+}, the hydrolysis of aluminium(III) at 25 °C in
a river water and in sea-water.
1. The following equilibrium reactions define the chemical system at infinite dilution:
1.
2.
3.
4.
5.

+

log β
14.00

-

→ H2O
H + OH ←
→ AlOH2+
Al3+ + OH- ←

9.0
18.7

→ Al(OH)2+
Al3+ + 2 OH- ←
→ Al(OH)3(aq)
Al3+ + 3 OH- ←

27.0
33.0

6.

→ Al(OH)4Al3+ + 4 OH- ←
→ Al3(OH)45+
3 Al3+ + 4 OH- ←

42.1

7.

→ Al(OH)3(s)
Al3+ + 3 OH- ←

33.5

2. Two components, H+ and Al3+.
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3. The chemical matrix and the charge of the components.

H+
Al3+
OHAlOH2+
Al(OH)2+
Al(OH)3(aq)
Al(OH)4Al3(OH)45+
Al(OH)3(s)

log β

H+

Al3+

z

0
0
-14.00
-5.0
-9.3
-15.0
-23.0
-13.9
-8.5

1
0
-1
-1
-2
-3
-4
-4
-3

0
1
0
1
1
1
1
3
1

1
3

Equilibria
nos.

-1
2-1
3–2x1
4–3x1
5–4x1
6–4x1
7–3x1

4. Start WinSGW, chose “New Chemical Matrix” from the “File” menu, and activate the
“Use ionic strength calculations” box. Enter the matrix with the charges of the
components and remember to change “Phase” to Solid for Al(OH)3(s). The correct
charges of all species will be calculated on entering the next tab. Don´t worry!

5. On the “Variation for each component” tab, chose to step log{H+}with constant steps
at a constant total concentration of Al(III). (Component 1 H+, option 10; Component 2
Al3+, option 2)
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6. On next tab, “Input data: Each component”, enter the start and step values for log{H+},
the total concentration of Al3+, and the number of points to be calculated.
To simulate a system which is always saturated with respect to Al(OH)3(s), Tc for Al3+ is
given as a high, fortuitous, value, e.g. 10 000 mM.

7. Simulate, on the tab “Ionic Media, Donnan and Temperature”, a river water by
entering a +1/-1 background electrolyte of 2 mM, and chose the Davies ionic strength
model with d = 0.3.
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8. Calculate
9. View log{H+}, log SAl, and the fraction of different aqueous aluminium species in
columns. (Col. 1: H+, log {a}; Col. 2: Al3+, log (|Tf|/M); Col. 3: Al3+, “Fi of selected
component in all species in solution” in the Column-Contents menu)

10. Return to the input by choosing “Chemical matrix” in the View menu and simulate a
sea-water by changing the background electrolyte concentration to 700 mM.

51

11. Calculate, and note that the previously defined column contents are automatically
used to report the results. If desired, these contents can of course be exchanged.
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5.6 Temperature dependent constants (H+-Cu2+-acetic acid)
Task: Calculate the distribution of species containing acetic acid between pH 2 and 5 in an acetic
acid-copper(II) system at 60°C using the formation constants evaluated at 25°C and reaction
enthalpy values.
1. The following equilibrium reactions describe the actual chemical system (Critical Stability
Constants, Volume 6). The constants are valid at 25°C. The corresponding reaction enthalpy
values are listed in the last column.
log β
-14.00

∆H (kJ/mole)
55.9

1

→ H + OH
H2O ←

2

4.76

0.42

3

→ HAc
H+ + Ac- ←
→ CuAc+
Cu2+ + Ac- ←

2.21

4.18

4

→ CuAc2(aq)
Cu2+ + 2Ac- ←

3.63

5.86

+

-

2. Three components: a) H+, HAc and Cu2+ , b) H+, Ac- and Cu2+
3. The chemical matrix and the reaction enthalpy of each species
a)
H+
HAc
Cu2+
OHAcCuAc+
Cu(Ac)2(aq)
b)
H+
AcCu2+
OHHAc
CuAc+
Cu(Ac)2 (aq)

log β
0
0
0
-14.00
-4.76
-2.55
-5.89
log β
0
0
0
-14.00
4.76
2.21
3.63

H+
1
0
0
-1
-1
-1
-2

HAc
0
1
0
0
1
1
2

H+
1
0
0
-1
1
0
0

Ac0
1
0
0
1
1
2

Cu2+
0
0
1
0
0
1
1
Cu2+
0
0
1
0
0
1
1

∆H

T1

Equilibria Nos.

55.9
-0.42
3.76
5.04

25
25
25
25

1
-2
3-2
4-2·2

∆H

T1

Equilibria Nos.

55.9
0.42
4.18
5.86

25
25
25
25

1
2
3
4

The temperature (T1) is the temperature at which the log β constants are valid. Enthalpy values
are set to zero for the components. Enthalpy values should be given in kJ per mole and T1 in
degrees Celsius.

53

4. Start WinSGW and enter the chemical matrix. Mark the “Use temperature dependent
constants” box which will activate the enthalpy and temperature columns.

5. Move to next tab “Variation for each component”.
Choose to step pH and to keep the total concentrations of acetic acid and copper constant.
(Component 1 H+, option 10; Component 2 HAc, option 2; Component 3 Cu2+, option 2).
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6. On the “Input data: Each component” tab, enter the start value “log {a}”, step length “Step” for
the first component H+, the total concentration of acetic acid and copper “Tc” and the number of
points.

7. Move to the “Ionic Media, Donnan and Temperature” tab and enter the target temperature.
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8. Calculate
9. Results
View -log[H+] and the distribution (Fi) of the acetic acid containing species (HAc, Ac-, CuAc+
and Cu(Ac)2(aq) ). (Col. 1: H+, -log{[x]/M}; Col. 2: HAc, Fi (aq) HAc; Col. 3: Ac-, Fi (aq) HAc;
Col. 4: CuAc+, Fi (aq) HAc; Col. 5: Cu(Ac)2(aq) , Fi (aq) HAc).
There is a short-cut to view the distribution of all species containing a specific component. By
choosing the actual component in the Component/species box and “Fi of selected component in
all species in solution” from the Column Contents menu the distribution of all species containing
the component is shown. The short-cut key for this is “<CTRL> + F”.

As seen, identical results are obtained regardless of component choice.
10. Plotting the results
Plot Fi as a function of pH.
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5.7 Donnan equilibrium (H+-Na+-Ca2+-fibre)
Task: Calculate the concentrations of sodium (1mM) and calcium (1mM) ions in the fibre
volume and in the suspension liquid (according to the Donnan theory) between pH 2 and 7. (The
Donnan theory applied to wood fibre systems has been described in detail in the work by
Lindgren, Wiklund and Öhman (Nordic Pulp Paper Res. J. 16(1), 24).
1. The following equilibrium reactions describe the actual chemical system.

1

+

-

→ H + OH
H2O ←
→ H+ + ≡COO≡COOH ←

2

log β
-14
-3.40

Additional information about the fibre system:
Surface site concentration

0.31mM

Solid phase concentration

10g/dm3

Specific surface area

100m2/g

Specific capacitance

0.27F/m2

Specific Donnan volume

1.4ml/g

In this example the Constant Capacitance Model is used to describe the electric double layer at
the fibre/water interface.
2. Four components: H+, ≡COOH, Na+ and Ca2+.
3. The chemical matrix with species charge(z) and surface charges (Q0, Q1 and Q2). Index “f”
represents ions in the fibre phase (Donnan phase) and “s” ions in the surrounding suspension
liquid.
+

Hs
≡COOH
Na+s
Ca2+s
OH-s
≡COOH+f
Na+f
Ca2+f
OH-f

log β
0
0
0
0
-14
-3.40
0
0
0
-14

H+
1
0
0
0
-1
-1
1
0
0
-1

≡COOH
0
1
0
0
0
1
0
0
0
0

Na+
0
0
1
0
0
0
0
1
0
0

57

Ca2+
0
0
0
1
0
0
0
0
1
0

Q0

Q1

Q2

0

0

0

z
1
1
2
-1

-1

0

0
1
1
2
-1

All mobile species (not surface complexes) should be entered twice, in both suspension liquid
phase and Donnan phase, in the matrix. The log β for a species in the fibre phase should be the
same as the log β in the suspension liquid phase.
4. Start WinSGW and enter the matrix. Mark the “Use Donnan models for surface calculation”
box which will activate the species charge column (z) and the “Ionic media, Donnan and
Temperature” tab. In WinSGW calculations it is only possible to involve Donnan equilibrium if a
surface is present. Remember to change the Phase properties for the species in the fibre phase to
“Donnan”.

5. Move to next tab “Variation for each component”.
Choose to step pH and to keep the total concentration of remaining components constant.
(Component 1 H+, option 10; Component 2 ≡COOH, option 2;
Component 3 Na+, option 2; Component 4 Ca2+, option 2; Surface 1 ≡COOH, option 20).
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6. On the “Input data: Each component” tab, enter the start value “log {a}”, step length “Step” for
the first component H+, the total concentration of fibre sites, sodium and calcium “Tc” and the
number of points.

7. Move to next tab “Input data: Surfaces”. Enter values for solid phase concentration,
capacitance 1, surface area and the specific Donnan volume.
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8. Move to the “Ionic Media, Donnan and Temperature” tab and mark the species in the
suspension liquid phase that represent the proton and the charged surface species causing the
Donnan potential.

9. Start the calculation
10. Results
View -log[H+] and log c for all sodium and calcium species. In the sixth column view lambda (λ
= [H+]f / [H+]s = [Na+]f / [Na+]s = ([Ca2+]f / [Ca2+]s)½ = [OH-]s / [OH-]f ).
(Col. 1: H+, -log{[x]/M}; Col. 2: Na+, log{[x]/M}; Col. 3: Na+f, log{[x]/M}; Col. 4: Ca2+,
log{[x]/M}; Col. 5: Ca2+f, log{[x]/M}; Col. 6: None, lambda).
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11. Plotting the results
Plot log {[x]/M}for sodium and calcium in both suspension liquid and fibre phase as a function
of pH.

In a new diagram, plot lambda (the distribution coefficient) as a function of pH.
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5.8 Find the best fitting model for the (H+-H3PO4) system
Task: Optimise the formation constant for PO43- using experimental data. The total concentration
of H3PO4 is constant during the experiment (10mM) and the following pH values (-log {H+})and
[PO43-] are available.
pH
9
9.8
10.2
10.5
11
11.2
11.8
12

[PO43-] (mM)
4E-03
0.03
0.07
0.12
0.25
0.66
2.2
3.2

1. The following model was entered into WinSGW in the first example in this manual.

1
2
3
4

+

-

→ H + OH
H 2O ←
→ H2PO4- + H+
H3PO4 ←
→ HPO42- + H+
H2PO4- ←
→ PO43- + H+
HPO42- ←

log β*
-14.00
-2.15
-7.20
-12.35

*Equilibrium constants valid at infinite dilution and at 25°C.
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2. Enter the model following the first five steps in the previous example. Change the formation
constant for PO43- from -12.35 to -11. This entail that the chemical matrix in WinSGW will have
the following content.
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3. Mark the “Optimisation” check box and change the Usage-value for PO43- from “Use” to
“Optimise logB”.

Up to 10 formation constant and/or capacitance figures could be optimised at the same time.
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4. Change to next tab “Variation for each component”. For this example we would like to vary
pH irregularly (Component 1 H+, option 8) and to keep the total phosphoric acid concentration
constant (Component 2 H3PO4, option 2).

5. Move to next tab “Input data: Each component”. Enter the “log {a}” values and the total
concentration of phosphoric acid “Tc”.
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6. Move to “Optimisation: Input data” tab. Choose PO43- in the “Component/Species” box, mark
the radio button for free species concentration ( [x] (mM) Conc. ) and enter the measured PO43concentration into the matrix marked in yellow.

If you have measured more than one type of data you could add up to fifteen data sets using the
remaining columns. If a data point is missing in a data set the abbreviation NaN (Not a Number)
could be used to exclude the missing data. Different weights could be applied to the data sets,
which will move the resulting model closer to the data set given the highest weight.
7. Start the calculation by pressing a “Calculate” button, using the Calculate menu or the short cut
key <F9>.

66

8. Two windows for the result will open, the normal grid for viewing results from a WinSGW
calculation and a window called “Optimisation results”.

The upper table shows the best fitting model found by WinSGW and the overall fit to the
experimental data. Sum of Squared Residuals (SSR) is the difference between the model and the
experimental data and should be as low as possible. The Goodness of fit value close to one
indicates that the resulting model has a good fit to the data. The starting value, the optimised
value and the standard deviation for each optimised variable is then listed. By pressing on
“Move” in the last column is the optimised value moved to the “Chemical matrix” and will then
be used as the starting value in the next optimisation.
In the lower part is the DX figures, the difference between the model and the experimental data,
for each data point listed and plotted. The squared sum of the DX figures is equal to the SSR.
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9. It is obvious that data point number 5 is strongly deviating from the model. Move back to the
Input window (View Chemical matrix) and Click in the first column for data point 5. This will
change the value for this point from INCLUDE to EXCLUDE.

10. Start the calculation by pressing a “Calculate” button, using the Calculate menu or the short
cut key <F9>.
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Excluding data point 5 reduced the SSR total figure and changed the Goodness of fit value closer
to 1.
Detailed information about the optimisation calculation (convergence criteria etc.) can be found
under “Help and Show optimisation information codes”. The convergence criteria could be
changed under “File, Preferences and Optimisation options”.
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